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1 Eykatdotaon tou Octave

1.1 Apxeia sykataoctaong
To apyeio eykatractacnc tou Octave Bpioketal otnv LoTOoEA IS TOU TPOYPAULOTOG

https://www.gnu.org/software/octave/

Ma toxUTePo «KaTERaOUOY UTIAPXEL KAl oTtov ftp server Tou MoAutexveiou

ftp.ntua.gr/mirror/gnu/octave/windows/

ALOAEYETE TO apyelo eykaTAoTAcNC TG TiLo poodatng £kdoong, m.x. octave-4.2.1-w32-installer.exe ) octave-4.2.1-
wb4-installer.exe avaloya pe To av To Aeltoupyikd cuotnua givat 32-bit rj 64-bit. (XHMEIQZH: Mnopeite va to Bpeite
ano tnv Evapén->Ynoloyiotng (6€€i kALk) -> I616TNTEC).

1.2 Awadikaocia eykataotaon
AdoU ohokAnpwBei to download Tou apxeiou eykatdotaong EEKWVA N EYKOTACTACN TOU TPOYPAUUATOGC. ITA EMOMEVAL
napabupa nou Ba epdaviotouv emihéEte Next> kat téAog Install.

A Eav sudaviotel éva prvupa oxetikd pe TG Java libraries, onwg ¢daivetal mapakdavw,
natnote Yes yla va cuveyioete.

. Octave has the capability to call Java libraries, but the installer was
$ unable to find a Java Runtime Envirenment (JRE) on this system,
Octave will still function without a JRE, only certain specific functions
will be dizabled. If a JRE iz installed later, Octave should be able to

detect and use it automatically. Continue with installation?

~

A (To ovopa tou dpakélou oto omoio Ba eykataotabel to Octave AEN emutpenetal va €xet
KEVO (space) xapaktripa. Avti autoUl pmopel va xpnowlomnotnbei to _ 1 to - . Zuvenwg dev
pmopel va eykataotabei katw amno tov ¢pdkelo Program Files.

Juviotatal va xpnowornownBei o npoerleypévoc ddkeloc tou Octave Onwc doivetot
TTAPAKATW.

\— _/



https://www.gnu.org/software/octave/
ftp://ftp.ntua.gr/mirror/gnu/octave/windows/

Choose Install Location
Choose the folder in which to install GNU Octave.

Setup will install GNU Octave in the following folder. To install in a different folder, didk
Browse and select another folder. Clidk Install to start the installation.

Destination Folder

Space reguired: 1,5GE
Space available: 8. 7GE

GHU Octave

Otav ohokAnpwOel n eykotaotacn epdaviletal To mapakatw napadupo.

Completing the GNU Octave Setup
Wizard
GMU Octave has been installed on your computer.,

Click Finish to dose this wizard.

Show Readme

< Back |I Einish I | Cancel




MNatwvrtag Finish gpdaviletal otov browser o evnUEPWTLK oeAlda Kal Tautoxpova EeKva n ektéleon tou Octave.
Tautoxpova, otnv entpavela epyaociog Exouv npooteBel U0 elkovidla

Octave-4.2.1
(CLT)

Octave-4.21
(GUD)

Ma tnv ekkivnon tou Octave oe ypadko meptBaiiov (Graphical User Interface — GUI) emihéyetal To SUTEPO ELKOVISLO,
Octave-4.2.1 (GUI).

n
\l,) (To Octave SiatiBetal kal oe portable popdn. Avti yia tov installer mou KCl‘EEBC'lOClTE\
MapaAnavw, Unopeite va katepaoete to avtiotowo .ZIP apyeio (m.X. to octave-4.2.1-
w32.zip | To octave-4.2.1-w64.zip) 10 onoio adol KATEREL GTOV UTTOAOYLOTH TIPETEL VAL
QTOCUUTLECTEL O€ KATIOLOV GAKEAOD KOl €lval ETOLUO TTPOG EKTEAEDN. ME QUTO TOV TPOTIO

to Octave pmnopei va ekteheotel akopn KL amo USB stick.

\ _/

2 To nepiBaAiov epyaciag Octave

2.1 Ekkivnon

|
To Octave eKKIVEL TATWVTOC TO £LKOVISLO (" otnv enuddvela epyaociag r avalntwvtag to Octave otnv Evapén twv
Windows. Tnv npwtn popd nou Ba ekteAeotel To mpoypappa epdaviletal To mapakdtw noapabupo



|8 ] Welcome to GNU Octaw

Welcome to Octave!

You seem to be using the Octave graphical interface for the first time on this
computer. Click ‘Mext' to create a configuration file and launch Octave.

The configuration file is stored in
C:fUsers/Thelser/.config/octave fqt-settings.

210 enopevo nmapabupo Sivetal n duvatdtnta va emAé€el kaveig edv Ba ocuvbéetal to Octave otnv LotoceAida Tou
TIPOYPAUHATOC WOTe Vo edavilel vEa Kal EL6NOELG OXETIKA e To Octave Kal TG TEAEUTALEG TOU EKBOCELC.

| 5] Welcome to GNU Octa

Community News

When the Octave GUI starts, it will check the Cctave web site for current news
and information about the Octave community. The chedk will happen at most once
each day and news will only be displayed if there is something new since the last
time you viewed the news.

You may also view the news by selecting the "Community Mews” item in the "Help”™

menu in the GUI, or by visiting http: /foctave. ora/community-news. html,

Allow Octave to connect to the Octave web site when it starts to display current news and information
about the Octave community.




Jtnv ouvéxela pe Next kal Finish Eekwva n ektéAeon tou Octave.

ctave [ —
gl B. 2 =N, .= T ac -
IEile Edit Debug Window Help MNews

IJJ & E | . “ I__] Current Directory: IC:‘{Jsers\‘meuser j ‘ .

File Browser = * | Command Window & x
* GNU Octave, wersion 4.2.1 -
IC’NSE’SMEUSE' j '@ Copyright (C) 2017 John W. Eaton and others.
N A Thiz iz free =software; see the source code for copwving conditions.
_ ame There is ABSOLUTELY NO WARRANTY; not even for MERCHANTABILITY or
#- [ .android FITNESS FOR A PARTICULAR PURPOSE. For details, type 'warranty'.
.. BigNox
. .config i0ctave was configured for "x86_64-wé4-mingw32".
L fop
| & -gimp-2-8 Ihdditional information about Octave is available at http://www.octave.org.
. thumbnails
L VirtualBox Please contribute if you find this software useful.
i3 Contacts For more information, visit http://www.octave.org/get-involved.html
M Desktop
= Documents ;I Read http://www.octave.org/bugs.html to learn how to submit bug reports.

For information about changes from previous wersions, type 'mews'.

Workspace T X

Filter [~ I j s
Name / |Class Dimension I‘u’alue

al | i

Command History F X
Filter T | |
exit

# Octave 4.21, Sat Oct 21 17:54:04 2017 GMT <unknown@unknov

< »

LI Command Windaow I Editor I Documemaﬁonl

2.2 PUOpon twv napabupwv epyaciog

To meptBaiAov epyaciag tou Octave meptéxet Stadopa AELITOUpYLKA opaBupa TTOU GKOTIO £X0UV va SLEUKOAUVOUV Kol
va emtayxuvouv tnv avamtuén twv sdpappoywv. Mo mAnpng Alota twv Staddpwv mopablpwv Kabwg Kal n
Suvatotnta gudaviong/anokpuPng toug UTapxeL otnv kaptéha Window. H Béon twv mapablpwv pmopsei va
PUBULOTEL KPOTWVTAC TA QTGO TOV UTIEPTLTAO TOUG Kal "oépvovtag" Ta (UE KPATNUEVO TOU APLOTEPO TIANKTPO TOU
TIOVTIKLOU) otnv emtbupuntn B€on.

File Edit Debug IWindow Help  Mews

WE v Show Command Window Ctrl+Shift+0
L w0 _ |
Show Command History Ctrl+Shift+1
Editor
File Edit View Show File Browser Ctrl+Shift+2
- Show Workspace Ctrl+Shift+3
| ol ﬁ I; l‘l v | Show Editor Ctrl+Shift+4
Show Documentation Ctrl+Shift+5
<unnamed> [
1 Command Window Ctrl+0
Command History Ctrl+1
File Browser Ctrl+2
Workspace Ctrl+3
Editor Ctrl+4
Documentation Ctrl+5
Reset Default Window Layout




MPOKELUEVOU VAL UTTAPXEL O HEYAAUTEPOC SUVATOG XWPOC Yl TO ypAaP Lo Twv Tpoypappdtwy (mapdbupo Editor)
KaBwg Kol yla TV mapakolouBnon twv amoteAeopdtwy (mapdbupo Command Window) , elval okomyo ta
napddupa autd va £Xouv LKAVOToLNTIKO XWpo péoa oto TeplPdAlov epyaciag tou Octave. MNo mapddelyua,
emAéyovtag otnv Kaptéla Window povo tov Editor katto Command Window kat ototxilovtag (ue drag and drop
omnod tnv enikedalida toug) ta mapdbupa pe tov Editor aplotepd kat to Command Window 8g€1d, o xwpog tou
Octave ¢aivetal wg €€ng:

Cowme e R 0O . e R R W )
File Edit Debug Window Help Mews |

H ™ & d [E] Currant[llradnry:IC:V_Isers\ThaUser j 4+ B
Editor 5 x| command Window & %
File Edit View Debug Run Help GNU Cctave, version £.2.1
_ - Copyright (C) 2017 John W. Eaton and others.
M h i O ? e 3N | oo u fgﬁ ‘k?:? ‘ o e ‘?\ n |This is fres software; sse the source code for copying conditions.
- [There is ABSOLUTELY NO WARRANTY; not even for MERCHANTABILITY or
<unnamed>ﬂ | FITNESS FCR A PARTICULAR PURPCQSE. For details, type 'warranty'.
1 [octave was configured for "x86_64-wé4-mingw32".
[kdditional information about Cctave is available at http://www.octave.org.
Please contribute if you find this software useful.
For more information, wvisit http://www.octave.org/get-involved.html
Read http://www.octave.org/bugs.html to learn how to submit bug reports.
For information about changes from previous wersions, type 'news'.
>
linet[1  |cok |l |enceding: SVSTEMl— eol: CRLFl— 4|

\:'!I) H dudtaén twv mapablpwv epyaciog Pmopel ovd maca otlypn va emoveéABel otnv
nipokaBopLlopévn NG popodr emdéyovrag Window->Reset Default Window Layout.

2.3 KaBoplopdg tpExovrog pakéAov

O kaBoplopog Tou TpEXovTog dakéAou otov omolo Ba amoBnkelovtal ta apxeia .m mou Ba dnuloupyouvtal amno To

Octave ylvetal matwvtog To €lkovidlo . Avtitou mpoemiheypévou pakélou (C:\Users\$USERNAMES) unopet

va emheyel évag aAlog ddkelog otov Tomkd Sioko yla mapadelypa otov dioko D: \STUDENTS\15101, onwg
daivetal mapakdatw:



File Edit Debug findo Help  News

™ h i D Current Directory: C:\Users\TheUser b ‘
“ ki .r

Editor
File  Edit

R Al ook [ EsTUENTSISI01 e oo EE

g
-
z

— E =
[’ Name | Size Type Date Modified
m‘ W& My Computer | vp
<k R TheUser

Directory:

Files of type: |Directories

Otav ohokAnpwOeil n dtadikaoia tote oto Current Directory Ba epdaviletal o emiAeyuévog pAKeAOG:

Eile

Edit Debug Window Help MNews

B[] curentoiectory: ExsTUbENTS\IS101

2.4 Emoyn xpwpatwv yia tov Editor

To Octave, 6ntwg kot to Matlab, mapéxetl tnv dSuvatdtnTa va eTUAEEEL 0 XPOTNG TNV YPOMOTOOELPA KOL TA XPWHLATO
mou Ba ypnowuomotlovvtal otov Editor. H SuvatotnTta XpwUOTIOMOU TOU KEWEVoU eival tblaitepa xpriown Kadwg
Silvel tnv SuvatotnTa otov Xpriotn va PAETEL T LOTA TOU KWOLKA PE SLPOPETLKO XPWHLA AVAAOY QL LLE TO TIEPLEXOLEVO
TOUG, TLY. K€ TNV HopdN TWV EVIOAWV, LLE TO AV XPNOLLOTOLETOL KATIOLO SECUEUUEVN AEEN, HE TO av €xel eloaxOel
KAToLlo Keipevo KA. O mpokaBoplopéveg pubuioelg yla to xpwua gival otnv kaptéla Edit->Preferences->Edit
styles. Matwvtag MAvVw o€ KATOW0 XpwHa gudaviletal n KaptéAa emAoyng XpwWUATWY ou Sivel Tnv duvatotnta
aAAaync tou emheypévou xpwpatog. Mpokelpévou va ouppadifouv ta xpwpata tou Octave e Ta avtioTowa xpwuota
TIOU Xpnotomnolouvtal oto Matlab mpoteivetal va yivouv ol €€1¢ al\ayEg



General | Editor Editor Styles |Tern1ina| I File Brawser I Workspace I Shortouts I Networkl

Select font, font size (as a difference from the default size), font style (bold, italic, underline), text color, and background color (for the
latter, the color magenta (255,0,255) is & placehalder for the default background color).

Octave | C++ | Perl | Batch | Diff | Bash | Teut | /\

Default Courier New ~ 1 B Ob Bi Ou {

Comment Default ~ 0o BHOe B Du) A

Command Default ~ 0 BHO @i Duf I

Mumber Default ~ 0o HOe B Od N

Keyward Default * 0 5 b Ei Dol W

Single-quoted string Default ~ o E O @i T N

Operator Default -0 B O @i @ul N I}

Identifier Default ~ 0o BHOe B Dulill

Double-quoted string Default 0o BEHEb Hi Elu [

2.5 Tevikég puBuioelg

Jtnv kaptéha Edit->Preferences umdpyel pla mAnBwpa emloywv mou kabopilouv tnv cuVvoAlkn Asttoupyia tou
Octave. Mia onpavtikn puBULon TIou SLEUKOAUVEL TNV EKTEAECT TWV MPOYPAUMATWY €lval otnv Kaptéha Terminal n
erhoyn Set focus to terminal when running a command from within another widget. H emthoyn aut 6a
TPEMEL VA glval evepyonolnpévn waote KaBe dopd mou ekTteAeital KAmoLo mpoypappa otov Editor va evepyormoleitol
to Command Window Wote 0 XprioTng va UMOPEL va ELOAYEL TLUEG /Kal Sedopéva KATT Xwpig va xpeldletal kabe
¢dopa va kavel kKAlk oto Command Window yLa va To EVvepYOMoLNO&L.

| General | Editor I Editar Styles | Terminal | File Browser | Workspace I Shortouts I MNetwork

-

Font [Courier Mew v] Fontsize 10 &
Cursor type: Use foreground color Cursor blinking
History buffer Size 1000 5| (Changing buffer size dears history)

et focus to terminal when running a command from within another widget
[ Print debug location in terminal window in addition to the marker in the editor

Terminal Colors

foreground - background |:|
selection |:| cursor -




2.6 Enavadopd apxitkwv puduicewv

Ot puBpioelg mou agdopouv to Octave OXETIKA e TNV BEon Tou, Ta mapabupa, SLddopeg MAPAUETPOL AELTOUPYLAC KATT,
anoBnkevovtal oto apxeio C:\Users\<ONOMA XPHETH>\.config\octave\gt-settings. Mnopei va
yivel emavadopd twv apxkwv pubuicswv tou Octave Slaypddovtag autd To apxeio amod tov dloko. e auth TV
TePUTTWon to mpoypappa Ba Eavatpéfel oav va ekteAeite mpwtn dopad, Omwe neplypadetol otnv mopaypado 2.1.

2.7 NoapdaBupo Bonbsiag
To Octave mapéxel éva napabupo Ponbelog To omoio evepyormoleital ypadovtag tnv evtoAj doc oto Command
Window. Autd £xel we anotéleopa va epdaviotel To mapdbupo Documentation.

~

- (/'f
\!I) To mapaBbupo Documentation eilval To AElTOUPYLKO €AV elval "ekTOC" XWPOU TOU
Octave (undocked). Ma va "Byel" kamnolo mopaBupo EKTOG Tou Xwpou tou Octave PEMEeL

va notnBel to ekovidlo = (undock widget) otnv dvw dgfld ywvia. Avd mdoa oty
Hmopel kamolo mapdBupo va favayivel pépog tou Octave (dock widget) matwvrag to

ewKovidlo E .

- _/

To mapaBupo tou Documentation meptéxel mAnpodopieg toco yia to neptBarlov epyaciag tou Octave 600 Kal yla
TG SLaBéoipeg eVIOAEG Kal ouvaptroelg. Ma tnv avalitnon Ponbeslag ylo KAmoLa CUYKEKPLUEVN EVIOAN UMopel va
XpnolpomotnBel n ypappn oto KAtw HEPoC Tou mapabupou tou Documentation.

Documentation B X
@ | [l

Section: Top ﬂ

Previous Section:

Mext Section: Preface

Up: (dir}

EHT Octawve

B .11

This mamual documents how to run, install and port GNU Octawve, as well
23 its new features and incompatikilities, and how to report bugs. It
corresponds to GHU Octawve wversion 4.2.1.

Menu:

« Breface

« Introduction 2 brief introduction to Octawve.
- Getting Started

« Data Types

« Humeric Data Types

- Strings

+ Data Containers

. Varisbles

. Expresasions

« Ewaluation
- b
. Btatements Looping and program flow control. _J

[” Global search




‘Evag mLo mpakTkog tpdnog yla avalitnon Bonbetag eival ar' eubeiag oto Command Window ypadovrag doc
akoAouBoUpevo amd tnv avalntolpevn evioAn, m.x. doc plot. Me tov Tpomo autd to Documentation Ba
eudavioel kateuBeiav tnv BonBela mou adopd tnv evtoAn plot.

ST
|
Command Window (S
GNU Octave, version 4.2.1
Copyright (C) 2017 John W. Eaton and others.
[This iz free software: see the source code for copying conditions.
o There is ABSOLUTELY NO WARRANTY; not even for MERCHANTABILITY or
Top \:l plutm | FITNESS FOR A PARTICULAR PURPCOSE. For details, type 'warranty'.
“1:; . [octave was configured for "x86 64-wé4-mingw32".
plo _
—— - plot (¥, ¥
- plos (X, Y, EMT) lAdditional information about Octave is available at http://www.octave.org.

: plot (..., PROPERTY, VALUE, ...)
- plot (X1, Y1, Please contribute if you find this seftware useful.

: plot (HR2E, ... For more information, wvisit http://www.octave.org/get-involved.html
S H=plot (...]
Produce 2-D plots.

Read http://www.octave.org/bugs.html to learn how to submit bug reports.

Many different combinations of srguments are possible. The For information about changes from previous versions, type 'news'.

simplest form is
>> doc plot
plot (¥} >>

where the argument is taken as the set of ¥ coordinates and the X
coordinates are taken to be the range ‘linumel (¥)'.

1f more than one argument is given, they are interpreted as

plot (Y, PROPERTY, VALUE, ...}

plot (X, ¥, PROPERTY, VALUE, ...)

or LI

Type here and press 'Return’ to search [ Global search

llines 1 leol: 1 [encoding: [SYSTEM | [eol: [CRLF | d|

2.8 Packages

To Octave cuvodeletal amo pla PeyaAn ykapa packages mou eival to avtiotolyo twv toolboxes tou Matlab. Ta
packages mapéxouv eMUTAEOV EVTOAEC KAl SUVATOTNTEC yLa SLADOPEC EMLOTNUOVIKEG Kol BeATIKEG Katnyople. MNa
napadelypa, umtdpyxouv packages yla enefepyaocia elkdvag, OTATIOTIKN, enefepyaoia onuatog, yewpetpia, aiyeppa,
OLKOVOULKA K.a.. H mAnpng Alota twv Stabéouwv packages divetal otnv otooeAida:

http://octave.sourceforge.net/packages.php

Oplopéva amno ta Stabéopa packages mapéxovral nén pe tnv eykatdotacn tou Octave. Me tnv evtoAn pkg list
epdavitetal oto Command Window pia Alota pe ta packages mou undpyouv eykateotnuéva nén oto Octave. MNa
napadelyua:

>> pkg list

Package Name | Version | Installation directory
_____________________ o
communications | 1.2.1 | ...\octave\packages\communications-1.2.1
control | 3.0.0 | ...\share\octave\packages\control-3.0.0
data-smoothing | 1.3.0 | ...\octave\packages\data-smoothing-1.3.0
database | 2.4.2 | ...\share\octave\packages\database-2.4.2
dataframe | 1.1.0 | ...\share\octave\packages\dataframe-1.1.0
dicom | 0.1.1 | ...\share\octave\packages\dicom-0.1.1
financial | 0.5.0 | ...\share\octave\packages\financial-0.5.0
fits | 1.0.7 | ...\share\octave\packages\fits-1.0.7
fuzzy-logic-toolkit | 0.4.5 | ...\octave\packages\fuzzy-logic-toolkit-0.4.5
ga | 0.10.0 | ...\share\octave\packages\ga-0.10.0
general | 2.0.0 | ...\share\octave\packages\general-2.0.0
generate html | 0.1.13 | ...\octave\packages\generate html-0.1.13
geometry | 2.1.1 | ...\share\octave\packages\geometry-2.1.1


http://octave.sourceforge.net/packages.php

gsl | 2.0.0 | .\share\octave\packages\gsl-2.0.0
image | 2.6.1 | .\share\octave\packages\image-2.6.1
instrument-control | 0.2.3 | .\octave\packages\instrument-control-0.2.3
interval | 2.1.0 | .\share\octave\packages\interval-2.1.0
io | 2.4.5 | .\OCTAVE~1.1\share\octave\packages\io-2.4.5
linear-algebra | 2.2.2 | .\octave\packages\linear-algebra-2.2.2
lssa | 0.1.2 | .\share\octave\packages\lssa-0.1.2
ltfat | 2.2.0 | .\share\octave\packages\ltfat-2.2.0
mapping | 1.2.1 | .\share\octave\packages\mapping-1.2.1
miscellaneous | 1.2.1 | .\share\octave\packages\miscellaneous-1.2.1
nan | 3.1.2 | .\share\octave\packages\nan-3.1.2
netcdf | 1.0.11 | .\share\octave\packages\netcdf-1.0.11
nurbs | 1.3.10 | .\share\octave\packages\nurbs-1.3.10
ocs | 0.1.5 | .\share\octave\packages\ocs-0.1.5
odepkg | 0.8.5 | .\share\octave\packages\odepkg-0.8.5
optim | 1.5.2 | .\share\octave\packages\optim-1.5.2
quaternion | 2.4.0 | ...\share\octave\packages\quaternion-2.4.0
queueing | 1.2.5 | .\share\octave\packages\queueing-1.2.5
signal | 1.3.2 | .\share\octave\packages\signal-1.3.2
sockets | 1.2.0 | .\share\octave\packages\sockets-1.2.0
sparsersb | 1.0.2 | .\share\octave\packages\sparsersb-1.0.2
specfun | 1.1.0 | .\share\octave\packages\specfun-1.1.0
splines | 1.3.2 | .\share\octave\packages\splines-1.3.2
statistics | 1.3.0 | .\share\octave\packages\statistics-1.3.0
stk | 2.3.4 | .\share\octave\packages\stk-2.3.4
strings | 1.2.0 | .\share\octave\packages\strings-1.2.0
struct | 1.0.14 | .\share\octave\packages\struct-1.0.14
tisean | 0.2.3 | .\share\octave\packages\tisean-0.2.3
tsa | 4.4.5 | .\share\octave\packages\tsa-4.4.5
video | 1.2.3 | .\share\octave\packages\video-1.2.3
windows | 1.2.4 | .\share\octave\packages\windows-1.2.4
zeromg | 1.2.1 | .\share\octave\packages\zeromg-1.2.1

>>

2.8.1 Evepyomnoinon evog package
Mo va xpnowdomnotnBel kamolo package oto Octave Ba MpEMeL TNV MPWTN Popd va yivel evepyomnoinon tou.

Napddelypa

‘Eotw OTL €xoupe ypael otov Editor to mpdypappa mou dpaivetal KATw apLotepd. To MPOYPAUUO QUTO:

- kaBapilel to Command Window

- oBnAveL 6Aegg Tic petoPANTEG OO TNV UVAUN

- doptwvel TNV elkdva 'marbles.jpg' (mou €xoupe 6N TonoBeTroeL oTov TpEXovTa PpAaKkeAO) Kal
- MELWVEL TIG SLOOTACELG TNG ELKOVOC KATA 50%

Itnv teheutalo ypauun, n eviohn imresize &ev elval evioAr tou Bacikol Octave aAAd umtdpxel oto package image,
TO omoio OMwW¢ pAvNKe TNV Tapanavw Alota gival nén eykateotnuévo oto Octave aAld lval ANMEVEPYOTIOLNLEVO.
‘Eva oxetiko pnvupa epdaviletal mapakdtw oto Command Window ota 8g€ld Omou pag EVAUEPWVEL OTL yLO. VoL
EVEPYOMOLOOUE TO package autd Ba mpémel va Swooupe oto Command Window tnv evtoAn

>> pkg load image



T N B ) V... T

File Edit Debug Window Help News

I — -
IJJ 1 h t| u CurrentDirechary:IC:\Tasos\pdaue j ‘ .
Editor & ¥ | Command Window X[
File Edit View Debug FRun Help warning: the 'imresize' function belongs to the image package from Cctave Forge a
b
which you have installed but not loaded. To load the Eackagei run 'Ekg

(W 20|62 a0

ip_example0 L.m [£] | Please read <http://www.octave.org/missing.html> to learn how you can
= contribute missing functionality.
error: 'imresize' undefined near line 10 column 4

3

load image' from the Cctave prompt.

1 % FoBdpLoe To Command Window

2 cloc; ) ) . error: called from

3 % IBfoe oheg TiC ueTafhnieg ip example0l at line 10 column 3
4 clear; P -

o

6 % ALGPooe TV oELEOVO

7 I=imread('marbles.ipg'):

8

9 % Mriwoe TL¢ SLooTdoELlC INC Kotd 50%

10 IZ2=imresize(I,0.5):

11

1 I
lline: 11_[col:[1_[encoding: SYSTEM | [eol: [CRLF |

780

Aivovtag tnv evioAr auth oto Command Window, evepyomnoleital to package to mpoypappa €nelta ekteAeitol
KQVOVIKAL.

2.8.2 NAnpodopicg oxetika e kamnowo package
Mo voa 8el kavelc MePLOOOTEPEG AETMTOPEPELEG OXETIKA HE KATOLO OmO TO eykateotnuéva packages pmopel va
XPNOLLOTIOLNOEL TNV EVIOAN pkg describe. MNa napddslyua, n evtoAn:

>> pkg describe image -verbose

Mapéxel MAnpodopieg oxetika pe To package image to onoio mepléxet pia BLBAL0BRAKN evtodwy enefepyaaciag elkdvag.
JUyYKekpLEVa, epdavilovtal n version Tou package mou elval EYKATECTNUEVO, O GUVTOMN Tieplypadr KabBwg Kat n
AlOTO TWV EVTOAWV TIOU TTEPLEXEL.

>> pkg describe image -verbose
Package name:

image
Version:

2.6.1
Short description:

The Octave-forge Image package provides functions for pro
cessing images. The package also provides functions for feature e
xtraction, image statistics, spatial and geometric transformation
s, morphological operations, linear filtering, and much more.



Status:
Loaded
Provides:
Analysis and Statistics
corr?2
edge
fftconv2
fftconvn
mean?
std2
entropy
entropyfilt
gtdecomp
gtgetblk
gtsetblk
graycomatrix
houghtf
hough line
hough circle
imgradient
imgradientxy
imhist
immaximas
immse
normxcorr?2
psnr
rangefilt
regionprops
stdfilt
Arithmetics
imabsdiff
imadd
imcomplement
imdivide
imlincomb
immultiply
imsubtract
Black and white image functions
applylut
bwarea
bwareafilt
bwboundaries
bwconncomp
bwdist
bweuler
bwfill
bwhitmiss
bwlabel
bwlabeln
bwmorph
bwperim
bwpropfilt
bwselect
fchcode
labelmatrix
makelut
Colour maps and Colour controls
colorgradient
rgb2ycbcr
wavelength2rgb
ycbcr2rgb
Display
montage
subimage
Enhancement and Restoration
histeq



imadjust
imnoise
imsmooth
medfilt?2
ordfilt2
ordfiltn
stretchlim
Filtering and Transforms
findbounds
fspecial
imfilter
imtransform
intlut
iradon
nonmax_supress
radon
rho filter
Morhophological Operations
bwareaopen
conndef
imbothat
imclearborder
imclose
imdilate
imerode
imfill
imopen
imreconstruct
imregionalmax
imregionalmin
imtophat
mmgradm
@strel/getheight
@strel/getneighbors
@strel/getnhood
@strel/getsequence
@strel/isflat
@strel/reflect
@strel/strel
@strel/translate
watershed
Read/write
analyze75info
analyze7b5read
analyze75write
tiff tag read
Region-based and block processing
bestblk
blockproc
col2im
colfilt
im2col
impixel
nlfilter
poly2mask
roicolor
Spatial transformations
cp2tform
imcrop
imperspectivewarp
impyramid
imremap
imresize
imrotate
imshear
imtranslate
maketform



rotate scale
tformfwd
tforminv
Types and Type conversions
grayslice
graythresh
im2bw
im2double
im2intl6
im2single
im2uint8
im2uintl6
imcast
imdither
imquantize
isbw
isgray
isind
isrgb
lab2double
lab2rgb
lab2single
lab2uintl6
lab2uint8
lab2xyz
label2rgb
mat2gray
rgb2gray
rgb2lab
rgb2xyz
xyz2lab
xyz2rgb
Utilities
checkerboard
edgetaper
getrangefromclass
imattributes
imgetfile
iptcheckconn
iptcheckmap
iptnum2ordinal
otf2psft
padarray
phantom
psf2otf



